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Overview

iR-ETN firmware V1.0.3.0 (or later) supports EtherNet/IP protocol. In EasyRemote 10 software, the
description file (EDS) of the EtherNet/IP device can be exported. By scanning the iR-ETN device in
EasyRemote 10 software, the EDS file can be generated according to the current module
configuration. The EDS file is then used by PLC or other EtherNet/IP Scanners for users to complete
network configuration in no time.

Eligible product: iR-ETN V1.0.3.0

Applicable software: EasyRemotelO V1.3.2.0 or later

For more information on updating iR-ETN firmware, please see

UMO19005E iR Series Firmware Update UserManual eng.pdf

This user manual explains how to generate iR-ETN’s EtherNet/IP EDS File, and how to connect PLC to
iR-ETN via EtherNet/IP.

Chapterl. How to Generate EDS File using EasyRemotelO
For more information on EasyRemotelO, please see
UMO018004E EasyRemotelO UserManual eng.pdf

Step 1. Launch EasyRemotelO, click [Automatic scan] to scan network for iR-ETN. The information

of iR-ETN and the connected modules is shown as below.

| Bl EasyRemotelo
. File Edit View Online Tools Help
‘E A BRDL o BB 2 B 0B fe i ©9 8

Project Window g X
10 Modules Address Map Parameter Power Information

~ B} iR-ETN (192.168.1.133)

ED #1-iR-DI16-K Chammel Name Tupe Cnline Value Project Yalue
il #2:iR-DM15-P ~ iR-ETM (192.168.1.133)

#1:iR-DI1G-K DI

#2:iR-DM16-P DI/ DO 0=00

Step 2. Click [File] » [Export EtherNet/IP EDS] and select the file to export tags.

gl EasyRemotelO
File Edit Wiew Online Tools Helg
Open Ctrl+0
3 New Ctrl+M
H save Ctrl+5
"}_'1 Save As
Export Tag

Export PLCopenxXML
Export EtherMNet/IP EDS

Step 3. Select the iR-ETN and click OK.


https://dl.weintek.com/public/iR/eng/UserManual/UM019005E_iR_Series_Firmware_Update_UserManual_eng.pdf
https://dl.weintek.com/public/iR/eng/UserManual/UM018004E_EasyRemoteIO_UserManual_eng.pdf
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Export Tag Dialog

IR-ETM (192.1688.1.133)

EDS file is successfully exported.

EasyRemotelO

Users/larry'

iR-ETN EtherNetlP Connection Guide

Successfully export 1 file(s) 'IR-ETM (192.168.1.133).eds' in the folder 'C:/
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Chapter2. CODESYS
This chapter explains how to connect two iR-ETN and iR Remote I/O in CODESYS.

Step 1. In EasyRemotelO scan and export EtherNet/IP EDS.
EXERE F >

v [} iR-ETN (192.168.1.155)
il #1:iR-AI04-TR
il #2:iR-DQ16-N

v E} iR-ETN (192.168.1.161)
il #1:iR-AI04-TR
il #2:iR-DM16-P

Step 2. Open a new project in CODESYS and select a device.

Standard Project X

You are about to create a new standard project. This wizard will create the following
—'i | objects within this project:
[E

- One programmable device as specified below

- A program PLC_PRG in the language specified below

- A cyclic task which calls PLC_PRG

- & reference to the newest version of the Standard library currently installed.

Device: CODESYS Control Win V3 (35 - Smart Software Solutions GmbH) P
PLC_PRG in: |Ladder Logic Diagram (LD} ~
Cancel

Step 3. Click [Tools] » [Device Repository...].

® CODESYS_iR_ETM. project* - CODESYS

File Edit Wew Project Build Online Debug | Tools

el S (B Package Manager... b
m Library Repasitary. ..
Devi |ﬂj Device Repository... |

=5 copesys R Visualization Styles Repository. ..

= ﬁ Device (
B @l] PLC License Manager...

=..
W | Scripting 3

License Repository. ..

- o P

i
E Customize. ..
= [ Options...

T ERITTE r e TP =l

Step 4. Click [Install...].
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Step 5.

Step 6.

iR-ETN EtherNetlP Connection Guide

22 Device Repository

£

Location: | System Repository
{C:\ProgramData\CODESYS\Devices)

X

Edit Locations...

Installed deyice descriptions:

Mame Vendor  Version  Description

+ m Miscellaneous
+ m Fieldbusses
£ EHMI devices

+- [ pLcs

+ ? SoftMotion drives

E Install... i

Close

Select [EDS and DCF files (*.eds, *.dcf)] and then select the first *.eds file.

" Install Device Description

ped

T « EFE » lary » 3% » CODESYS » EIP v O EEEP »

ESEE - HEEHE
b EDE ~ =B EuEH
B Apple iPad [ iR-ETN (192.168.1.155).eds 2020/6/11 L5 09:26
¥ T [ iR-ETM (192.168.1.161).eds 2020/6/11 5 09:26
i
b=
W=
= EkR
- B
i, Windows8_05 1

— ATRIDA i hC

BEEZEN) iR-ETM (192.168.1.155).eds

v| EDS and DCF files (*.eds, * def v

L) HA

After importing the file, the iR-ETN is added under EtherNetIP Remote Adapter.

28 Device Repository

Location: | System Repository
{C:\ProgramData\CODESYS\Devices)

X

w Edit Locations...

Installed device descriptions:

Mame Vendar
=+ == EtherNet/IP Remote Adapter
m EtherMetlP Adapter 35 - Smart Software Solutions GmbH
m Generic EtherNet/IP device 35 - Smart Software Solutions GmbH
m Generic EtherMNet/IP device 35 - Smart Software Solutions GmbH
£l e | weintek Labs. , Inc.
+ - = FtherMet{TP Sranner

<

~ Install...
Uninstall

Bxport..

= &% C:\Users\arry\Documents\CODESYS\EIPYR-ETN (192, 168, 1, 155).eds
¥ Device R-ETN" installed to device repository.

Details..

Close
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Step 7. Add an Ethernet device.

m Add Device

iR-ETN EtherNetlP Connection Guide

Name: |Eﬂ’\emet

Action:
@® Append device

evice () Plug device () Update device

[Enter a string for a fulltext search in all devices... | Vendor: | <all vendors>

Name Vendor Version  Description
= [ Miscelaneous
Ei Ethernet 35 - Smart Software Solutions GmbH 3.5.15.0 Ethernet Link.
Ei iBus Weintek Labs., Inc. 1.0.0.0 cMT-CTRL local fieldbus to iR Modules
= [0 Fieldbusses
+--€AN CANbus

- b EtherCAT
+ - HB Ethernet Adapter
= & EtherNet/IP
=- HB Ethernet Adapter

@ 35 - Smart Software Solutions GmbH 3.5.10.0 EthernetLink.

m Ethernet 35 - Smart Software Solutions GmbH 3.5.11.0 Ethernet Link.

m Ethernet 35 - Smart Software Solutions GmbH 3.5.15.0 Ethernet Link.
- = EtherNel/IP Scanner

+ - w Modbus

+- H¥ Profibus
+ . H¥ profinet 10
*- 8§ sercos

Group by category Display all versions(for experts only) [] Display outdated versions

m Name: Ethernet
Vendor: 35 - Smart Software Solutions GmbH
Categories: Ethernet Adapter, Ethernet Adapter, Ethernet Adapter
Version: 3.5.10.0
Order Humber: -
Description: Ethernet Link.

=

Append selected device as last child of
Device

&  (You can select another target node in the navigator while this window is open.)

Add Device Close

Step 8.  Assign an interface (Ethernet).

[f] Ethernet x

General

Interface: | Pl

Status

Ethernet Device /0 Mapping

Information IP&ddress 152 .

—— Default Gateway 132 .

@ Use Qperating System Settings
O Change Operating System Settings

Subnet Mask 255 . 255 ., 252 . 0
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iR-ETN EtherNetlP Connection Guide

Metwork Adapters bt
Interfaces:
Wame Description IP Address ~

work Comnection 192.168.1.151

WiFi3 Realtek RTLE192CT Wireless LAN 802.11n USE 2.0 Network Adapter | 192.168.100.10

(&g EER* 10 | Microsoft Wi-Fi Direct Virtuel Adapter 00.0.0

iR * 11 | Microsoft Wi-Fi Ditect Virtuel Adapter #2 oono

IP &ddress 192 168 . 1 .151
Subnet Mask 355 0255 0252 . O
Diefanlt Gateway 192 1og . 1 254

MAC Address 44: 37 E6:CEFS 06

Step 9. Add an EtherNet/IP Scanner.

Caneel

Devices. T % X| [ Add Device
=45 copEsYs R_ETN -

= [ Device (CODESYS Control Win V3) Name: [EtherNet_TP_Scanner

= @U PLC Logic Adtion:

=} application
) Library Manager

@ Append device () Insert device

Plug device () Update device

[ pLc_PRG (PRG)

[Enter a string for a fultext search in all devices... | Vendar: | <Al vendors>

= (& Task Configuration
= g MainTask Name Vendor Version  Description

& PLC_PRG = [ Fieldbusses

[ Ethernet (Ethernet) = == EtherNet/IP

+-#8 Modbus
+  Profinet 10

[ EtherNet/iP Scanner
[ EtherNet/P Scanner

= <= EtherNet/IP Local Adapter
m EtherNet/IP Adapter
[ EtherNet/P Adapter
[ EtherNet/P Adapter
= &= EtherNet/IP Scanner
(6} 35 - Smart Software Solutions GmbH ~ 3.5.10.30  EtherNet/IP Scanner
35 - Smart Software Solutions GmbH 3.5.11.0 EtherNet/TP Scanner
35 - Smart Software Sclutions GmbH 3.5.15.20 EtherNet/IP Scanner

35 - Smart Software Solutions GmbH 3.5.10.20 A device that works as an EtherNet/IP Adapter.
35 - smart Software Solutions GmbH 3.5.11.0 A device that works as an EtherNet/IP Adapter.
35 - Smart Software Solutions GmbH 3.5.15.20 A device that works as an EtherMet/IP Adapter.

*Please note that [Auto-reestablish Connections] must be selected.

(1] EtherNet_IP_Scanner X

General

Options

EtherMet/IP Scanner If0 Mapping

I Auto-reestablish Connections I

Status

Information

Step 10. Add the first iR-ETN.

Devices - B X
= & copesYs R ETV -
=il Device (CODESYS Control Win v3)
= B pLciogic
=} Application

) Library Manager
BF PLc_PrG (PRE)
={#8 Task Configuration
= & ENIPScamnerIOTask
& EtherNet_IP_Scanner.10Cydle
= £ ENIPScamnerServiceTask
@) EtherNet_IP_Scarner.ServiceCy:
= 22 MairTask
8] pLcprG
= [ Ethernet (Ethernet)
[ EtherNet_IP_Scanner (EtherNet/IP Scanner)

[ Add Device

Name: [R_ETN

Actian:
@ Appenddevice () Insert device

ce () Update device

Enter @ string for a fulltext search in al devices.

. ‘ Vendor: | <All vendors>

Name
= [ Fieidbusses
= EtherNet/IP
= <= EtherNet/IP Remote Adapter
ﬁ] EtherNetlP Adapter
(i Generic EtherNet/PP device
EF[REM

Vendor Ve

35 - Smart Software Solutions GmbH  Ma
35 - Smart Software Solutions GmbH 3.1
Weintek Labs., Inc. Ma
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Start from step 3 again to add the second iR-ETN'’s *.eds file. This will overwrite the *.eds file of the

first iR-ETN.
Add the second iR-ETN.

= ﬂj Ethernet (Ethernet)

= ﬁ EtherMet_IP_Scanner (EtherMNet/IP Scanner)

E} ir_ETM_155 (R-ETM)
E} iR _ETM_151 (R-ETN)

Step 11. The default iR module setting is shown. Add new parameters in User-Defined Parameters

The initial values can be set after adding new parameters.

tab.
® CODESYS_iR_ETN_20200611.project* - CODESYS - u] x
File Edt Vew Project Buld Online Debug Tools Window Help
S = = He Ol | 6 X v
Devices - 2 x| [} memss x -
=43 conEsYs R ETN_ 20200611 -
= Win eneral
{’:ﬁ":c(f::mc”"“‘ V3 ¢ lie  Name Value Bitlength | Abortifemor  Jump'tofinefemar  Nextline  Comment
e O Applcation Connections 1 slot 1AI04 TR 4 Celsius / Fafvenheit Setting.  Celsius. 16 O O [
@on "
() brary Manager Acsenble=
= @ Task Confguratan
- $ ENIPScannerIOTask EtherNet/IP /O Mapping
&) ethertiet_IP_Scanner.[0Cyde:
= & ENPScarerServiceTsk Status
] ethertiet_IP_Scanner.ServiceC)
= & MainTask Information
8 rou
= (@ ethernet Etnernet)
= (] Ethertiet IP_Scanner (Etheriet/IP Scanner)
£} R_EM_155 REM) \
B IRETN_161 (R-ETN) Move Up Move Down New... Delete... Edit...
>
Lastbuid: © 0 B0 Precomple: o/ Current user: (nobody) @
| Select Parameters x
Name Class Instance  Attribute  Type Minimum  Ma: ™
slot 1 AI04_TR ch#0 Input Scale Range Lower Limit 112 1 8 INT -32758
slot 1 AI04_TR ch#1 Input Scale Range Lower Limit 112 1 g INT -32768
slot 1 AI04_TR ch#2 Input Scale Range Lower Limit 112 1 0 INT -32768
slot 1 AI04_TR ch#3 Input Scale Range Lower Limit 112 1 11 INT -32768
slot 1 AID4_TR ch#0 input Filter Frame Size 112 1 12 INT 0
slot 1 AID4_TR ch#1input Filter Frame Size 112 1 13 INT 0
slot 1 AID4_TR ch#2 input Filter Frame Size 112 1 14 INT 0
slot 1 AID4_TR ch#3 input Filter Frame Size 112 1 15 INT 0
slot 1 AID4_TR 4 Celsius / Fahrenheit Setting 112 1 19 INT 0
slot 1 AID4_TR ch#0 Temperature Offset 112 1 20 INT -32768
slot 1 AID4_TR ch#1 Temperature Offset 112 1 21 INT -32768
slot 1 AI04_TR ch#2 Temperature Offset 112 1 22 INT -32758
slot 1 AI04_TR ch#3 Temperature Offset 112 i 23 INT -32788
w
P P P,
£ >
Show Parameter Groups [] Generic Parameter
Name: slot 1 AI04_TR 4 Celsius / Fahrenheit Setting
Class: 112 3 Datatype:  INT
Instance: = Bitlength: 16 2
Attribute: 19 2 value: Celsius v
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E} iR_ETH_155 x

General

Connections

Assemblies

User-Defined Parameters

EtherNetfIP /O Mapping

Status

Information

Step 12.

Line Mame Walue Bitlength ~ Abortiferror  Jumptaolineiferror  Nextline
1 slot 1 AI04_TR 4 Celsius { Fahrenheit Setting 16 (] (] 0

In EtherNet/IP 1/O Mapping tab find the |0 address and start editing the program.

El iR_ETN_155 x

General

Connections

Assemblies

User-Defined Parameters

EtherNet(IP /O Mapping

Status

Information

Find Filter Show all -

Variable Mapping Channel Address Type Unit  Description

+ 4y slot 1 AI04-TR ch#0 %LIW0 INT New Help String
+ slot 1 AID4-TR ch#1 IWL INT New Help String
oAy slot 1 AIO4-TR ch#2 %IWZ INT New Help String
+o Ay slot 1 AI04-TR ch#3 %IW3 INT New Help String
+-"g slot 2 DQ16-N DO HQWO WORD New Help String
+ Py slot 1 AI04_TR 4 Celsius / Fahrenheit Setting %QW 1 INT New Help String

Guide
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Chapter3. Rockwell CompactLogix/ControlLogix
Rockwell CompactLogix and ControlLogix can be edited using RSLogix 5000.
Step 1. Open [Tools] » [EDS Wizard] and import iR-ETN'’s EDS file.

i RSLogix 5000 - RockWellL.23E [1769-L23E-QB1 20.12]
IHE SRE EEY FEQ ERL ESO00|Ssom Hmm

REH & s 2@ o[ | E a
B |
B 0. I rmw — o E
b L SAHIES L.
T2 b oo q} ot i
e 2 - SAD 3
| _ SHE |
BN < EDStWizard
..... izah ) r
""" EER SR
Cugtom Tools .
- [% ACwlePmgram Bl ContolFLASH
=15 WMain Task
Import EDS file following the on-screen instructions.
Eockwell Antomation’s EDS Wizard |z|

Welcome to Rockwell
Automation's EDS Wizard

- The EDZE Wizard allows wou to:

- register EDV-based devices.

- e gister a device.

- change the graphic images associated with a dewvice.
- create an EDE file from an woluown device.

- upload EDE file(z) stored in & device.

To continve click Next

FT—#w-| B |
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Rockwell Antomation’s EDS Wizand

Optons
That tazk do you want to complete?

(o Hegizter an EDE file(z).
This option will add & device(s) o our databaze

(7 Thiregister a dewice.
Thiz option will remove a device that has been registered by an EDE file from
our database.

™ Create an EDE file.
Thiz option creates a new ED file that allows onr software o recognize your
device.
(=
=

iR-ETN EtherNetlP Connection Guide

Rockwell Antomation’s EDS Wizand

Remstration
Electronic Diata Sheet file(z) will be added o wour svsterm for vse in Rockwell
Automation applications.

(* Fegizer a single file

(" Register a directory of EDS files -

Wamed:
|C:".Dcucmnents and Settingsid 4w DocwmentsiF-ETHN (192.168.1.133) &

*If there iz an dcon file (dco) with the same name as the file(z) yon are registering
then this image will be asmociated with the dewvice.

To perform an installation fest on the file(z), click Mext

< F—#E | TF—FHW- R

10
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Eockwell Automation’s EDS Wizard

EDZ File Installation Test Results

Thiz test evaluates each EDS file for ervors in the EDE file. This test does not
guarantee EDE file walidity.

- '] Installatinn Test Results
E| chdocnments and settingswd v docomentsic-etn (1921631 1330 2dz

View file...

Rockwell Antomation’s EDS Wizard

Change Graphic Image
Vo can change the graphic image that is associated weith a device.

Product Types
Change icoi... = @ Comumumcations LAdapter

iH-ETH

2@ | [F=HNE]

11
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Step 2.

Eockwell Automation’s EDS Wizard

Final Task Summary
Thiz iz a rewiew of the tagk wou want fo complete.

=¥ on wonld like to register the following device.

iR-ETH

t—#@| [FT-Hw-| @w |

Rockwell Automation’s EDS Wizard @

© You have successfully completed the EDS Wizard.

Right-click on [Ethernet] and select [Add Module...].

12
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it RSLogix 5000 - RockWellL23E [1769-L23E-QB

FiHE REE BEREIM HEED EEL BEC

Bl 0. I rw e
FaEH p.| oK 1}’
Fimta [T BAT

=| [T I/0 @

Controller E3E 35

=50 FEHI8R RockWellL23E
S EHIERTE
[0 =4 8edse 1988
[T fnep /3888
=51 1S
=58 CyweleTask
Eﬂ; ACyleProgram
=& MainTask
Eﬂ; MadnProgram
[T S EIeeE FaE
= i=E0EA
[T a2
(3 4dd-on BEXIES
=55 g
L ApEs
L e
L £dd-On-Defined
L FAmES
L iEERTEs
3 gam
=51 A I ECE
= Compactlogixi323E-QB1 Fif
§0 1769-L23E-QB1 RockWellL22E
-4 1769-L23E-QB1 Ethemet Port Locall

&5
=80 Compacti) 7] AddModule...
=55 B
C M
C My
B
$TED »
3 : -




D‘DWE!NTEK iR-ETN EtherNetlP Connection Guide

Select Module Type

BE | Modulke 53 | Wdist |

e | [FeuEEc)

B5 fat HEEE Ecill|

Weintek Labs, [ Commumnications: Ldap

£ | >
1 #211 Module 2580 B33
[] BlzRE (L) [(meE | [ =m | [ == |

Enter iR-ETN'’s IP address and device name. The device name will be used in the tags.

W 3k Module g|
Bl |3§}§ " Module {58 " Internet FHH " ﬁDEEE|
Eachii iE-ETH. x iR-ETH
HERETR Weintek Labz., Inc.
ART LocalEHE
EH M) |ETH] | 1207 Pt
1HBR () £ @ EHAFE E): 1921681 H
OTe itk @: | |
Oxfzw: | |
Nodule FEX
W 1.1
METFEHE T 3E Module
LR Ezdusive Cumex
e RO [ ®mE | [ B#E© | [ Kb

Step 3. iR-ETN’s Input/Output Data can be found in the tag.



D WE!NTEK iR-ETN EtherNetIP Connection Guide

RSLogix 5000 - RockWellL23E [1769-L23E-QB1 20.12]* - [Controller Tag - RockWellL23E(controller)]

e SRE ZEC 2RO BRL GBS0 TE0 00 BED

aEE & v &8 G & = v @
Rl 0. Frw ] Bﬂ B543 : [AB BTHTF-11192 185 1 159\Backplana\h  ~ %
FizHl b o 0
Fimin 2 =1 4 »
I\ s (CFIF AT AT A e
I Bl == @®1: | fRockhelllziE v | BT @ : |FH Tag |
= ] FRE8 RockWelL23E : -
o = e [£# Tag_|DataTwwe [ [staminel  |ms [mest
= | |*FETNC _0B3C.R_ETHx_ 1ADFO524.C.0 Read/Wiite O
(3 hneba 783 | |=ETM _0B3C:R_ETHx_98DESDOC:0 Read/wiite O
=3 ETM:I.ConnectionFaulted BOOL Read/Wiite Deximal
=58 CycleTask —
= [:g, ACyelsProgram | T ETNIData SINT([3] Read/wiite Decimal
= MainTack | HETMLDaE0] SINT Read/Wiite Decimel
=65 MsinProgin + ETN:.Datall] SINT Fread/wite sl
TR E —
2R
i + ETN:I Dataf2] SINT Read/Wiite Decimal
[ AL A AR |- ETHD _OGACR_ETHx FA74D033:0:0 Fead/Wiite 0
™ Eﬁf!a*m = ETNO.Data SINTIT) Fead/Wiita Dacimal
1 Add.on BREWIES | HETNODatsl0] SINT Fead/Wiite Desimal
Femt e = fom— P = I

Select the corresponding bit when programming.

. . ETH v | BT FRE Tag W
| &% —=|[Date Type  |iEH |~
F ETH:C _DEaCaE _ETH..
- ETHI _63CHR_ETN...
ﬂ — ETH:O _OA3CHE_ETH..
. ETN:ODits STNT[1]
ﬂ E'I'I'I:D.Dat:a.[ﬂ:ﬂ BINT
| D123 4/5|6|7 |
w
[ Controller [C) ]
[ Frogram (F) |
EThE | Diata(0].0 ETh: O Diata[0] 0
0 1E
ArrayBool[0]
1 1E

(353
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Chapter4. Panasonic FP7

Panasonic FP7 CPS41E CPU supports EtherNet/IP, please use Control FPWIN Pro 7 software to edit
the program.

Step 1. Use static IP for PLC.

W3 FP7_CPS41E.pro - Control FPWIN Pro 7 - The IEC 61131-3 programming system - [P addresses
Project Object Edit Online Monitor Debug Extras Window Help

EH e

a9

Project variables
il | e L] Us ltem name
@ Project [DA\ProjectPLC\Panasonic\FPWIN_Pro\FP7_Cff (846 | Lis= [Pud addiess
v @ PLC(FP7 CPS41E) 847 Aut y obtain IPv4 address Disable
v - System registers 857 192.168.1.43
& Memorysize 859 255.255.252.0
& Hold en/off 861 192.168.1.254 -
/‘15 Acton errar 246 "Yes
& Timelnut 847 "Disable
v Serial ports
#° Como 881 e o
_}b COM1 873 4to0 128
#° comz £97
v @ Ethernet 22 - Disable
@ IP addresses e
Time synchranization 933 Alternate DNS 5
B Web server
HTTP client
FTP server

Step 2. Open EtherNet/IP Setting » [EDS File] » [Register...] and import iR-ETN’s EDS file.

W FP7_CPS41Epro - Control FPWIN Pro 7 - The [EC 61131-3 programming system - Program_1
Project Object Edit Tools Online Monitor Debug Extras Window Help
SHE T o8 9% 8 | @
Project
Fo e | @2 U S
@] Project [D:\ProjectPLC\Panasonic\FPWIN_Pro\FP7_(]
v @ PLC (FP7 CPS41E) = H'

~ # System registers Scan List Delete P
#7 Memory size w Edit Comment...
#° Hold onfoff Whole
/’5 At I/OMap - S addto Sean List
‘ ;b onerer o Scanlist-U Init L

3

& —_1__"|| 9 o

. EtherMet/IP Setting
File Edit View EDSFile Setting Help

Beagister...

Timeout Device Property...
- Serial ports
_)b COMO Import Device Data Base...
F° Com1 Export Device Data Base...
&7 comz
v @ Ethemet
@ IP addresses
Time synchronization
B Web server
HTTP client
FTP server
FTP client
SMTP client
& System connections (4 system connes
User connections (16 user connection
&_ EtherMet/IP (1 connection)
Routing
@? TCP time settings

L T (PR

Step 3. Right-click on iR-ETN and select [Add to Scan List].

w
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Device List o
By Wendor By Device
Device Mame Device Type 2

FP7CPU UMIT AFPTCPS41E Communications Ac

FRTCPU UMIT AFPTCPS31... Communications Ac

FE7CPU UNIT AFFTCPS41... Communications Ac

FPOH COMTROL UMIT AF... Communications Ac

w
Register EDS File...

< Delete EDS File

Save Setting| | Read Se Edit EDS File Comment...

Add to Scan List

Device Property...

Import Device Data Base...

Export Device Data Base...

Scan List a
. FP7 CPS41E(192.168.1.43) Usakle Connections:
----- I/ Map - Scheduled Connections: 0
EI Scan List - Use Connections: 1
= M (1] R-ETN (192.168.1.44)

Exlusive Cwner

Step 4. [Setting] » [EtherNet/IP Basic Configuration...]

Wl Ctherblet/IP Setting

File Edit View EDS File @ Setting Help

= Hl ¥ oGy @ Etherklet/IP Basic Configuration... '

S0 P

Set [Auto Allocation] to “No”.

17



E‘ WE!NTEK iR-ETN EtherNetIP Connection Guide

EtherMet/IP Basic Configuration x
Auto Allocation
LD Device Starting No. (Setting Range: 0 to 16383) ]
Refresh Unit (Setting Range: 0 to 65535) 252 Word
RUM/IDLE bit operation of cydic communication Mormal v
Cydic Communication Start Timing Auto ~
Cydic Communication Node Connection Wait Time (Setting Range: 1 to 300 s) |GD | 5
Cydic Communication Connection Automatic Reconnection Wait Time (Setting Range: 1to 120 s) | 5 | 5
Message Communication Timeout (Setting Range: 10 to 65530 ms) | 10000 | me
Connection Timeout (Setting range: 1to 10s) | 1 | g
TTL for Multicast (Setting Range: 1 to 255) E |
Multicast Address Setting Method Auto v
Mo, of Multicast Addresses (Setting Range: 1 to 258) 256
Multicast Starting IP Address 239 .255. 0 . 0
IGMP Query Send Enable Invalid w
IGMP Query Transmission Interval (Setting Range: 1 to 18000 5) a0 5
Cancel
Step 5. Device Allocation is currently empty.
Wl EtherNet/IP Setting b
File Edit View EDSFile Setting Help
FH| ¥ =Y
Scan List ® | W « » M /Connection Setting ' Device Property % Device Sefting
Bl FP7 CPS41E(192.168.1.43) Usable Connections oo Pl
/O Map - Scheduled Connections: 0
B Scan List - Use Connections: 1 Node Name iR-ETN Device Mame iR-ETN
- [1] IRETN (192.168.1.44) Gonnection Name vl G B oolcation Tops Exclusive Owner
Compatibility Check. Follow Adapter Rule ~ GOS Transmission Disable ms
Gommunication Method Instance Timeout Period RPIx 4 ~
Tnput Send Trigzer Gyelic Parameter Setting (Tnput:200ms # Output: 200ms)
Input Information (T>0)
RPI(10.0ta 1000ms) me Device Allocation
Connection Type Faint to Point v Starting Devi Size Offset - Add
Thstance ID 100 !
2 Edit
Data Size 1 WWord 3
Refresh Method Batch = M v Delete
Total Data Size: 0 YWord Remaining Data Sizes 1 Word
< > Output Information (0>T)
Device List o
RPI (100t 1000ms) ms Device Allocation
By Vendor By Device
Tstance 1D 160 Starting Devi Size Offset " Add
Device Name Device Type ~ .
FP7CPU UNIT AFP7CPS41E Communications Ac Do 8 ! e 2 Gl
FP7CPU UNIT AFP7CPS31.. Communications Ac Refresh Method Batch w 3
FP7CPU UNIT AFP7TCPS41... Communications Ac + v Delete
FPOH CONTROL UNIT AF__ Communications Ac Total Data Size: 0 Word Remaining Data Size: 1 Word
iR-ETN Communications Ac
v
< >
Read Settine ok Gancel

Right-click on iR-ETN and select [Reallocate Device].
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Scan List L N P
. FP7 CPS41E(192.168.1.43) Usakle Connections:

----- I/ Map - Scheduled Connections: 0 Va
EI Scan List - Use Connections: 1 Mo

Exlusive Cwne Add Connection

Delete
Delete All

Rearrange Scan List

Reallocate Device
=3 Copy

£ cut

Settings can be saved for other projects to read by clicking [Save Setting].
Click [OK] to finish settings.

Step 6. Configure I/O mapping in [Global variables] tab for use in the program

Class Identifier FP address |IEC address Type Initial
o] VAR_GLOBAL bT1 LD0.0 2eMX8.0.0 BOOL FALSE
1 VAR_GLOBAL  bOuti LD1.0 96MX8.1.0 BOOL FALSE
2 VAR_GLOBAL  bOut2 LD1.8 hMXB.1.8 BOOL FALSE
3 VAR_GLOBAL bT2 LD0.3 FehMX8.0.8 BOOL FALSE
- ferm = == I

CODESYS® is a trademark of 3S-Smart Software Solutions GmbH.

Other company names, product names, or trademarks in this document are the trademarks or registered trademarks of their respective companies.
This document is subject to change without prior notice.
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